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Abstract
Background: Conservation and breeding programs for forest species require efficient pollen quality monitoring strategies to maximize collec-
tion, storage and pollination efforts.
Question: Can the ImageJ image analysis software be implemented to efficiently monitor pollen viability and germinability for quality testing?
Studied species: Pseudotsuga menziesii (Mirb.) Franco
Methods: Tetrazolium staining and germination on 10 % Brewback media was used to test Douglas fir pollen quality. Two macros for automated 
counting were developed with ImageJ free software using digitized microscopic images, and were tested to evaluate provenances, germination 
in different media, dehydration/rehydration and freeze-storage treatments, and finally to compare pollen quality between mature trees and GA-
induced strobili from juvenile trees.
Results: Automated monitoring of pollen quality was feasible because the software suitably distinguishes viable from non-viable pollen grains 
due to differential tetrazolium staining that translates into pixel density, whereas germinability was assayed based on pollen size and circularity. 
This tool was used to guide the selection of appropriate pollen handling conditions and compare pollen production in adult and GA-induced 
juvenile trees. Pollen flash-freezing and storage at -80 °C showed recovery between 74 and 98 % of its initial germinability after rehydration; 
however, viability detected by tetrazolium is reduced, suggesting that handling and storage affect the reliability of the test.
Conclusions: The flexibility of the Fiji software allowed the development of an efficient and accurate macro for monitoring P. menziesii pollen 
quality, reducing invested time and effort involved, which supports future research on its conservation physiology and its successful application 
for germplasm production.
Key words: imaging, macros, pollen conservation, pollen germinability, Pseudotsuga menziesii, tetrazolium, viability.

Resumen
Antecedentes: Los programas de conservación y producción de semilla en especies forestales requieren estrategias eficientes para el monitoreo 
de polen que maximicen los esfuerzos de recolección, almacenamiento y polinización. 
Pregunta: ¿Puede implementarse el software de análisis de imágenes Image J para monitorear eficientemente la viabilidad y germinabilidad 
del polen?
Especie de estudio: Pseudotsuga menziesii (Mirb.) Franco
Métodos: Se utilizó tinción por tetrazolio y el medio Brewback 10 % para evaluar la calidad de polen. Se desarrollaron macros para la automa-
tización del conteo mediante el software libre Image J usando imágenes digitalizadas. Se comparó el polen de distintas procedencias, madurez 
de árboles, medios de germinación, deshidratación/rehidratación y almacenamiento por congelación.
Resultados: El software distingue adecuadamente polen viable del no viable mediante la tinción diferencial que se traduce en densidad de pix-
eles, mientras que para germinación se consideró el tamaño y circularidad. La herramienta permitió guiar la selección de condiciones apropiadas 
para el manejo de polen, así como comparar la producción de árboles adultos y juveniles inducidos con GA. El congelamiento de polen permitió 
recuperar entre 74 y 98 % de la germinación después de la rehidratación; aunque la detección de viabilidad por tetrazolio disminuyó, mostrando 
que el manejo y almacenamiento afectan la confiabilidad de la prueba.
Conclusiones: La flexibilidad del software Fiji permitió el desarrollo de  macros eficientes y precisas para monitorear la calidad del polen de 
P. menziesii, al reducir el tiempo y esfuerzo implicados. Esto apoya investigaciones futuras sobre la fisiología de su conservación y aplicación 
exitosa para la producción de germoplasma.
Palabras clave: análisis de imágenes, conservación de polen, macros, Pseudotsuga menziesii, tetrazolio, viabilidad.
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Forest genetic improvement programs in coniferous species rely on the abundant production of quality seed 
for use in reforestation. Most conifers are mast-seeding, exhibiting synchronized cycles of seed-producing 
and non-producing years, that vary between species and populations, and have important reproductive and 
ecological implications under natural conditions (Redmond et al. 2019). However, these cycles inevitably 

affect the availability and number of seeds from select trees that can be supplied for plantation efforts. Enhanced seed 
production has been achieved in species of Pinus (Kong et al. 2018), Picea (El-Kassaby & Reynolds 1990), Larix 
(Lee et al. 2011), and especially Pseudotsuga (El-Kassaby & Ritland 1986, Muñoz-Gutiérrez et al. 2010), with vary-
ing levels of success, and mostly in seed orchards, through cultural practices that range from promoting abundant 
strobili  in juvenile and mature trees to pollen collection, and performing controlled pollinations between selected 
individuals (Crain & Creg 2018). As ensuring high-quality pollen production is critical when assessing reproductive 
function and efficiency, and for maintaining seed orchard yield, it is an essential part of directed breeding and tree 
improvement programs (Li et al. 2021).

Monitoring pollen quantity (production), viability, and germination capacity over time provides valuable insight 
into strobili induction practices. It is also crucial to follow pollen collection and handling procedures -along with 
short or medium-term storage strategies- to sustain controlled pollination efforts, especially if there is a lack of syn-
chrony in the development of the male and female gametes (Araújo de Oliveira et al. 2021). Common approaches 
for assessing pollen viability include various staining techniques, in vitro assays to detect respiration, electrical con-
ductivity of leachates, and electric properties of pollen membranes, in vitro germination, in situ germination and seed 
set evaluation (Webber & Bonnet-Masimbert 1993). The suitability of these approaches depends on their efficiency, 
reliability, and the resources available regarding specific project or research needs and constraints (i.e., equipment, 
pollen availability).

Viability stains and germinability tests remain the most practical and sought-after techniques for discriminating 
between viable and non-viable grains, even if they are not a guarantee of successful fertilization and seed set. Vi-
ability stains are used to visualize specific compounds, cellular compartments, or metabolic activity associated with 
aborted and non-aborted pollen grains (Stanley & Linskens 1974, Rodriguez-Riano & Dafni 2000, Tello et al. 2018). 
Tetrazolium salt-based dyes are the most frequently used and rely on the action of dehydrogenase enzymes in meta-
bolically active cells to catalyze the colorless 2,3,5-triphenyl tetrazolium chloride to produce a red or purple color 
that clearly distinguishes living from non-living colorless cells (Stanley & Linskens 1974). Concomitantly, pollen 
germination tests are based on calculating the percentage of pollen grains that produce a pollen tube when exposed to 
a liquid, either water or a more complex medium, that may include salts and sugars as osmoticums, as well as growth 
regulators (Webber & Bonnet-Masimbert 1993, Dumont-BéBoux & von Aderkas 1997). 

The evaluation of pollen quantity and quality using viability stains and germinability tests can be a laborious pro-
cess with poor reproducibility, making high-throughput image-based analysis an attractive and useful alternative to 
shorten the time and effort involved in processing, while allowing easy storage of the images, electronic counts, and 
calculations. The ImageJ (Fiji is Just ImageJ) analysis platform, an open-access, user-friendly and intuitive software 
focused on biological image analysis, is particularly amenable to performing pollen quantification tasks quickly 
(Schindelin et al. 2012, Tello et al. 2018, Ayenan et al. 2020). 

The automation of the analysis is achieved through macros -codes that contain the complete process steps- which 
can be easily applied to a series of images to obtain a single file containing all the results. It is a relatively straightfor-
ward process, based on setting the analysis parameters and using the differences in pixel density between the object 
(pollen) and the background to detect the size and circularity of the object of interest. Reproducible pollen counts 
consistent with manually obtained data have since been achieved in numerous species (Costa & Yang 2009, Tello et 
al. 2018).

A further step consists of implementing the software to estimate viability. The open-source code PollenCounter 
(also from Fiji) was initially created to automate phenotyping of grape pollen grains after Alexander’s staining, 
also by analyzing pixel density (Tello et al. 2018). This code was subsequently optimized to assess pollen viability 
in heat-stressed tomatoes (Ayenan et al. 2020), and a significant correlation was found with results obtained from 
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manual processing, indicating that the analysis can be adjusted to different species. However, image-based analysis 
for estimating germinability is mostly underwhelming; neither Fiji nor PlantCV, a semi-automated software designed 
for this purpose (Castillo et al. 2022), allow full automation due to the additional complexity conferred by pollen tube 
growth. Notwithstanding, such software may be useful for automating evaluation in species where pollen morphol-
ogy during germination follows a more uniform or predictable pattern. 

Douglas fir (Pseudotsuga menziesii (Mirb.) Franco) is one of the most ecologically and economically important 
conifers native to North America, which grows naturally from Canada to central Mexico, with plantations having 
been introduced to Europe, New Zealand, Australia, and Chile (Hermann & Lavender 1999). Unlike Canada and the 
United States, where Douglas fir forms large and continuous forests, populations in Mexico grow in small and isolat-
ed stands among other coniferous and hardwood species. This has resulted in a highly fragmented and discontinuous 
distribution (Ventura-Ríos et al. 2010), typical of rear-edge populations (Gugger et al. 2011). The ecological, mor-
phological, phenological, and genetic differentiation of these southern-limit populations reflects local adaptations to 
topographic and environmental variables (Ventura-Ríos et al. 2010), suggesting their potential role as a reservoir of 
genetic diversity in changing climates, that can be valuable to genetic improvements and breeding efforts (Gugger et 
al. 2011). However, high anthropogenic pressure due to land-use change, inappropriate forest management practices, 
and pest attacks, has reduced the density of trees of reproductive age, thereby increasing inbreeding, which has taken 
its toll on reproductive success and natural regeneration (López-Upton et al. 2015). 

Douglas fir is subject to special protection by the Mexican government (SEMARNAT 2010), indicating the urgen-
cy for better management programs in natural populations and to promote commercial plantations and germplasm-
producing units to support conservation and harvesting strategies (López-Upton et al. 2015). Silvicultural practices 
that promote the induction of male and female strobili in young trees have been explored, mainly through the appli-
cation of gibberellic acid 4/7 (GA4/7) (Muñoz-Gutiérrez et al. 2010). Nevertheless, as is common in conifers, pollen 
production in young trees is a limiting factor due to its scarcity (Muñoz-Gutiérrez et al. 2010); therefore, operational 
seed production necessitates collecting pollen from mature trees. This represents the additional challenge of obtain-
ing, transporting and storing until use, making monitoring pollen quality throughout the handling period essential to 
ensure its fertility (Webber & Bonnet-Masimbert 1993).

Upon shedding, Douglas fir pollen is mostly spheroidal, lacking bladders, pores, or furrows, and between 90-100 µm 
in diameter (Owens & Morris 1990). The exine is thin and smooth, and generally splits open and is “thrown off” 
when moistened, allowing the pollen grain to swell and elongate considerably (up to five times its size) (Dumont-
BéBoux & Von Aderkas 1997). This elongation represents a pre-germinative stage that leads the pollen grain that 
settles in the micropyle towards the micropylar canal. Once in proximity to the nucellus, germination per se occurs, 
with the formation and growth of the pollen tube to complete fertilization (Owens & Morris 1990).

Pollen tube formation in vitro is rare and requires the addition of flavonoids or other complex compounds to 
mimic chemical signals believed to be produced by the nucellus to help direct tube growth (Dumont-BéBoux & Von 
Aderkas 1997). Notwithstanding, the pre-germinative stage is readily replicated with the addition of a drop of water 
or medium, allowing the differentiation of four morphotypes, according to pollen grain shape and length: type 1 is 
elongated, with a minimum of twice the length of a hydrated grain; type 2 is oval, with up to a 50 % increase of the 
size of a hydrated grain; type 3 is a round grain with no elongation; and type 4 are grains with evidence of damage 
(plasmolysis). Of these, type 1 and 2 pollen are considered to reflect overall germination capacity and are related to 
higher seed sets in controlled pollination assays (Webber & Bonnet-Masimbert 1993) and may represent a useful 
approximation to assay pollen quality. Furthermore, the simplicity with regard to shapes and elongation patterns 
provides an opportunity for automated digital evaluation. 

To generate an automated method that could be useful for future management and conservation programs aimed at 
seed production and genetic improvement in P. menziesii, we sought to standardize a procedure to count viable and 
non-viable pollen grains, as well as the four morphotypes of the pre-germinative stage, using the free ImageJ (Fiji is 
Just ImageJ) software.
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Materials and methods

Pollen collection. Douglas fir pollen samples were obtained from two sources in Central Mexico: 1) Adults, corre-
sponding to three samples (a1-a3), were obtained from a mix of six trees of approximately 80 years of age, from San 
Pedro Nexapa, Amecameca, Estado de México (19° 07’ 66” N and -98° 70’ 65” W; 2,800 m asl). After performing an 
initial test to check viability and germinability, the three samples were mixed to form a pool to increase the amount 
of pollen available for experimentation, and its moisture content was determined (MC: 29 %) (Webber & Painter 
1996). An additional sample (a4) was provided at a later time and was kept independently. 2) Induced samples were 
collected at four different dates from trees between 7 and 8 years of age treated with gibberellic acid (GA4/7) to pro-
mote strobili initiation, at the Parque Ecoturístico Bosque Esmeralda, Ejido Emiliano Zapata, Amecameca, Estado 
de México (19° 07’ 14” Lat. N and -98° 44’ 06” Long. W; 2,640 m asl): i1 (March 1st), i2 (March 17th), i3 (March 
22nd), and i4 (April 3rd). All samples were obtained from strobili that were still closed when collected, then kept in 
paper bags and allowed to dry for 24 hr at room temperature before extraction. Pollen samples were stored at 4 °C 
in airtight tubes until use.

Standardization. To guide the creation of a macro to automate pollen counts, the effectiveness of the viability stain-
ing method and germination media were evaluated, while assessing the correct way to capture the images and select 
working parameters for the software. Counts were performed in randomly selected fields at 10X magnification under 
an Axiostar Plus microscope (Carl Zeiss, Oberkochen, Germany). Images were digitized with an Axiocam MRC 
camera and AxioVision software (Axio Vs40 v. 4.8.2.0).

Pollen viability staining with tetrazolium salts.- The pollen viability staining was based on Vieitez-Cortizo (1952). 
Approximately 3 mg of pollen was placed in an Eppendorf-type tube with 200 µL of 2,3,5-triphenyltetrazolium 
chloride solution (TTC; 0.2-1.0 % solution in 1/15 mol phosphate buffer, pH of 7.2), and incubated for 90 min at 
55 °C in an FD 56 drying oven (Binder™, Tuttlingen, Germany). Red/purple pollen grains were considered viable, 
whereas clear/colorless cells were non-viable. Ten images were obtained per sample. The percentage of viability was 
calculated using the formula:

Pollen germination.- Three media were tested: 1) double distilled water (ddH2O); 2) Brewbaker and Kwack (BK) me-
dium 100 % (Webber & Bonnet-Masimbert 1993) (10 % sucrose, 100 mg/L H3BO3, 300 mg/L Ca(NO3)2, 200 mg/L 
MgSO4, 100 mg/L KNO3, and H2O; pH 5.3); and 3) BK 10 % medium (pH 5.3). Approximately 3 mg of pollen was 
placed in an Eppendorf tube and 200 µL of the appropriate medium was added. Incubation was performed at 26 °C 
for 48 hr in a 100A Stabil-Therm Dry Type Bacteriological Gravity Convection Incubator (Blue-M, New Columbia, 
Pennsylvania, USA). For each medium, 30 images were obtained. Germination percentage was calculated with the 
formula: 

Automated viability and germination analysis.- To adapt the program ImageJ (Fiji is Just ImageJ) (v. 1.53) (Schinde-
lin et al. 2012), all images were saved in a predefined folder to execute the batch mode analysis (Tello et al. 2018). 
The size and circularity ranges of the pollen grains were obtained using the function Analyze>Analyze particles, 
where a value of 1 indicates a perfect circle while values close to 0 express the elongation of the object.

Viability test.- The command path selected was Image>Color>Split channels, resulting in three channels: red, green, 
and blue. The red channel was chosen to identify total pollen, while for the green channel for the detection of viable 
pollen (Tello et al. 2018). Depending on the lighting and pixel density of the image, the Image>Color>Threshold 
was adjusted. The image was converted to black and white with Process>Binary>Convert to mask. The 
Process>Binary>Fill holes option was used to fill the blank spaces in the objects. The Watershed function was used 
to separate closely spaced grains. The Analyze>Analyze particles tool was used to count pollen grains. In the red 
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channel, pollen was counted with a size of 3,000 to 30,000 pixels and a circularity of 0.30 to 1.00, while for the green 
channel, the same size but a circularity of 0.66 to 1.00 were established. 

Germination test.- The Image>Type>8 bit command path was selected to convert the image to grayscale, and the 
same steps were followed as in the viability test. The threshold was adjusted, and the Exclude on Edges option was 
selected in order to avoid miscounting pre-germinated pollen as non-germinated, forming two groups: germinated 
pollen grains (type 1 and 2) and non-germinated pollen grains (type 3 and 4). The size range for germinated pollen 
grains was from 16,000 to 40,000 pixels with a circularity of 0.20 to 0.97, while for non-germinated pollen grains it 
was 3,000 to 16,000 pixels, with a circularity of 0.20 to 1.00.

A macro was made to automatically analyze all images: 150 for viability and 90 for germination (Supplementary 
Material). The analysis comprised 3,391 pollen grains for the viability test, with an average of 22.6 grains per image, 
whereas germinability was evaluated from a total of 1,611 pollen grains with an average of 17.9 grains per image. The 
results of the pollen counts were obtained in a Microsoft Excel file (2007). 

Validation. The macro was used to expand the analysis to a larger set of images to verify correspondence between au-
tomated and manual counting, as well as to finetune experimental conditions: 150 images were obtained from viability 
assays that tested pollen from different sources (a1-4 and i1-4) and dehydration and rehydration treatments (pool); 160 im-
ages were used to evaluate pollen germinability from the different sources (a1-4 and i1-4) or different growth media (pool).

Pollen dehydration.- Either saturated MgCl2 (15 g dissolved in 5 mL of distilled water) (Connor & Towill 1993) or 
silica gel (Dinato et al. 2018) was poured into Petri dishes (90 × 15 mm) in which a smaller petri dish (60 × 15 mm) 
was introduced as a support for ~10 mg of pollen (pool sample) placed on aluminum trays. The external Petri dish 
was covered, sealed with Parafilm® and incubated at 24 °C for 4 hr. Weight was recorded every hour until 10 % MC 
was obtained. After this time, ~5 mg of the pollen was vacuum sealed in a commercial vaccum sealer (85 kPa Au-
tomatic Food Sealer, KOIOS) and stored at 4 °C for 24 hr. The remainder was rehydrated in a humid chamber for 3 
hr at 26 °C. Viability was assessed in ten images for each sample. A total of 2,638 pollen grains were analyzed, with 
an average of 17.5 grains per image.

Germination media.- Seven different media were tested, consisting of either BK 100 % and BK 10 % supplemented 
with sucrose 10 %, or mannitol 5 %, or indole-3-acetic acid 10 ppm (IAA) (Table 1). The percentage of germination 
was calculated from 10 images of each medium. A total of 3,300 pollen grains were analyzed, with an average of 
20.6 grains per image.

Evaluation. The full protocol was implemented to compare pollen quality under various conditions. All pollen un-
derwent rehydration before testing.

Pollen quality in adult and induced samples.- Pollen viability and germination were compared between samples ob-
tained from mature trees (using a1-4 as replicates) and trees induced with GA4 (using i1-4 as replicates). A total of 
120 images were analyzed. 

Refrigerated pollen viability through time.- Viability of the “Pool” sample was tested before and after storage at 4 °C 
for a period of 4 months (n = 40).

Pollen quality of the adult and induced samples stored at -80 °C for 50 days: Undehydrated pollen (~5 mg) was 
placed inside 7 × 13 cm Mylar bags and vacuum sealed. Samples were frozen with liquid nitrogen for 2 min and 
stored at -80 °C for 50 days. Before testing, the samples were thawed at ~70 °C for 3 min and rehydrated for 3 hr in 
a humid chamber. Only samples with the highest percentages of germination and viability before freezing were used. 
Ninety images were analyzed for viability and germination.
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Statistical analysis. Normality and homogeneity of variances of the data for all variables (viability and germination) 
in the different experimental stages were verified with the Shapiro-Wilk and Fligner-Killeen tests, respectively (α: 
0.05). For standardization data, t-test was used to determine significant differences (α: 0.05) between automated and 
manual counts, and the Pearson correlation coefficient assessed the two datasets. A Bland-Altman plot was calculated 
to estimate the accuracy between the two approaches. 

The Kruskal-Wallis H test and post hoc Wilcoxon signed-rank test were used to determine significant differences 
in the percentage of pollen germination between the different media. For macro validation, the nonparametric Mann-
Whitney U test was used to determine significant differences (α: 0.05) between the results of manual and automated 
counting. The Spearman correlation coefficient was used to calculate the association between the two counts. For 
evaluation, the t-test was used to analyze the differences in pollen viability and germination between adult and in-
duced trees. The t-test along with the nonparametric Mann-Whitney U test were used to determine significant differ-
ences in pollen viability and germination before and after storage in each sample. 

RStudio v. 1.4.1106 was used for all statistical analyses (RStudio Team 2020).

Results

Standardization. Automated viability and germination testing required standardization of staining conditions and 
the appropriate medium for pollen grains to germinate. Tetrazolium staining allowed the status of pollen grains to 
be clearly distinguished, where viable grains showed stronger pigmentation than non-viable grains, on a very light 
background that did not interfere with subsequent image analysis (Figure 1A). 

Selection of the germination medium was based on the germination percentages obtained, which were manually 
calculated (data did not show a normal distribution, P = 0.0023). Although double-distilled water quickly induced 
germination (78 %), an increasing loss of viability was observed after 24 hr, as well as contamination; whereas ger-
mination was favored in both BK 100 and 10 % medium (92 and 94 %, respectively) when compared to bidistilled 
water (P = 0.0005). Consequently, BK 10 % medium was used in all subsequent tests (no significant difference be-
tween BK 10 and 100 %, P = 0.1852). 

Viability analysis using Fiji produced two images per field showing total and viable pollen-grain counts (Figure 
1B, C). With the setting for the green channel image, the pixel density in non-viable grains was decreased, enabling 
viable grains to be distinguished (Figure 1C). For the germination test (Figure 1D), two images were obtained per 
field, where germinated pollen grains (Figure 1E) and non-germinated grains (Figure 1F) could be observed, differ-
entiated by their size and circularity.

In the macro standardization (240 images), both viability and germination data showed a normal distribution (vi-
ability manual counting, P = 0.0943; automatic counting, P = 0.1612; germination manual counting, P = 0.3301; 
automatic counting, P = 0.0592). t-test showed no significant differences between manual and automatic calculations 
of viability (P = 0.8831) and pollen germination (P = 0.9776) (Figure 2). 

Media BK 100 % medium BK 10 % medium

+ 5 % mannitol ✔ ✔
+ 10 % mannitol ✔

+ 5 % sucrose ✔

+ 10 % sucrose ✔

+ 10 % sucrose + AIA ✔

+ 5 % mannitol + AIA ✔

Table 1. Tested media for pollen germination. AIA: Indole-3-acetic acid. BK: Brewbaker and Kwack medium.
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Figure 1. Viability and germination test of Pseudotsuga menziesii pollen grains. (A) Staining with tetrazolium chloride. Automated counting: (B) the red 
channel shows total pollen; and (C) the green channel shows only viable pollen. Arrows indicate non-viable pollen. (D) Germination test in 10 % BK 
medium, showing the different types of pollen morphologies: type 1 (T1), type 2 (T1), type 3 (T3) and type 4 (T4). Automated counting: (E) colors show 
germinated pollen types 1 and 2; and (F) colors show ungerminated pollen types 3 and 4. 

Figure 2. Box plot comparing the percentages obtained manually (blue) and automated (red) counting. (A) viability: the maximum line from the manual 
counting has a small deviation, the interquartile range and the median have a similar distribution. (B) germination test: there is a little difference in the 
distribution of the interquartile range and the median, the minimum line has the largest deviation. 
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Furthermore, a high positive correlation between manual and automatic counting which was obtained for the 
viability (P = 9.89e-12, r = 0.98) and germination (P = 0.0169, r = 0.99) tests, which was further confirmed by the 
Bland Altman analysis. Differences between the measurements made with both approaches were within 95 % confi-
dence intervals and the points were distributed without any pattern (Figure 3A, C). 

Validation. The viability tests performed on different samples did not show a normal distribution (manual counting P 
= 0.0002, automatic counting P = 0.0003); nonparametric Mann-Whitney U test revealed no significant differences 
between manual and automatic counting (P = 0.9314) and a high positive correlation between both methods (P = 
1.42e-10, rs = 0.97). Viability varied between provenances and tree maturity from 42 to 83 %, with lowest values 
observed for induced trees (Figure 4A); whereas germinability ranged between 37 and 83 %, reflecting the results 
obtained for viability (Figure 4B). 

Figure 3. Dispersion diagram showing the correlation between manual (MC) and automated (AC) counting for (A) viability test; (C) germination test. 
Manual counting is indicated with the red line, automated counting with the blue line. Bland Altman plot showing the differences between the two 
counting methods versus the mean of the two methods in the viability test (B) and germination test (D). Confidence interval limits are presented as red 
dotted lines.

Dehydration had a negative impact on pollen viability, with the use of silica gel being the least aggressive 
-showing 25 % decrease- while over 50 % of viability was lost under MgCl2 and vacuum. Prior to staining, re-
hydration for 3 hr allowed a partial recovery, suggesting that it is a necessary step for adequate monitoring of 
viability (Figure 5A). Non-germinability testing on different media of the adult, induced (90 images) and Pool 
(70 images) samples showed non-normally distributed data (manual counting P = 0.0001, automatic counting P = 
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0.0003); a high correlation between both counting methods (P = 4.57e-15, rs = 0.98) was observed with no signifi-
cant difference between them (P = 0.3422). Incorporating sugars and AIA had a positive impact when compared 
to double-distilled water (P < 0.05) but was similar to BK 100 and 10 % (Figure 5B, P > 0.05). Furthermore, a 
significantly higher germination percentage was found using BK 10 % compared to the medium with 10 % sucrose 
+ AIA (P = 0.0038), with with 5 % mannitol (P = 0.0057), or mannitol 5 % + AIA (P = 0.0175), so continued 
supplementation of the basic medium was not considered, particularly due to its tendency to become contaminated 
in the presence of sugars.

Evaluation. The standardized tools for quality evaluation were applied to compare pollen from induced and mature 
trees. Additionally, we tested the usefulness of flash-freezing and storage at -80 °C as a medium-term conservation 
strategy. 

Pollen quality in induced trees.- Viability and germinability of pollen from adult and induced trees showed a normal 
distribution (viability: adult trees P = 0.6994, induced trees P = 0.8638; germination: adult trees P = 0.6412, induced 
trees P = 0.7274); the subsequent t-test showed that these had significantly higher values in adult trees (P = 0.0351 
and P = 0.0291, respectively). In addition, induced trees showed a greater variation in both parameters (Figure 6), 
reflecting the decrease in quality throughout the season, being at its highest in February and tapering off towards 
May (Figure 4A, B). 

Figure 4. Percentage viability (A) and germination (B) of locations determined manually (blue) and with Fiji software (red). a1-4: Adults, i1-4: Induced, 
P: Pool.

Medium-term storage.- The viability of the refrigerated Pool sample was determined over time, and it was found to 
decrease by ~ 50 % within four months of storage (Figure 7). Although all material was rehydrated, freezing reduced 
the estimation of viability detected by tetrazolium staining between 13 and 29 % (Figure 8A); in contrast, frozen 
pollen retained between 74 and 98 % of its germinability (Figure 8B).
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Discussion

Standardization and validation. Assessing pollen quality through the automated analysis of digital images represents 
an efficient approach to monitor many samples; in the present study, manual counting of 30 images took about 45 
min, while the software performed it almost immediately (~60 seconds, which also includes the generation of Excel 
databases), reducing time and manual labor. Although many methods exist for quantifying the number of pollen 
grains, few have been adapted to discern viability, and even fewer are able to quantify germinability in an easy, in-
expensive, and reproducible manner (Costa & Yang 2009). Here, we applied Fiji software (Schindelin et al. 2012), 
which, by using the Analyze particles tool, was effectively adapted to viability staining and to the detection of mor-
phometric changes used for assessing germinability in P. menziesii pollen. Furthermore, the procedure was reliable 
and reproducible as the programming language allowed the recording of commands to create a macro (Schindelin 
et al. 2012), which was later applied to a collection of images obtained from pollen tested under various conditions.

Staining with tetrazolium proved to be a good alternative for determining the viability of fresh Pseudotsuga pol-
len because of its rapidity, reproducibility, and accuracy. Its adaptation to the Fiji software was straightforward since 
viable and non-viable pollen are easily discernible in the green channel, whereas total pollen number is counted by 
using the red channel. The use of TTC presented the additional advantage of staining only the pollen, leaving a clear 
background, which improved and facilitated the handling of the images. This contrasts with what was observed with 
either Alexander or Peterson staining, where the background takes on a pink color that generates noise that must 
be removed during image processing (Tello et al. 2018). Adapting the macro to other similar stains, such as MTT 
(3-[4,5-dimethylthiazole-2-yl]-2,5-diphenyltetrazolium bromide), is feasible but would require testing and optimiza-
tion, since viable pollen grains may show irregular black lines on its surface (Rodriguez-Riano & Dafni 2000), which 
can pose difficulties for automation.

Figure 5. Germination percentage of provenances (A) and on different media (B) calculated manually (blue) and with Fiji software (red). M: dehydrated 
with magnesium chloride, S: dehydrated with silica gel, R: rehydrated, V: vacuum stored. A: bidistilled water, B: BK 100 % medium; C: BK 10 % me-
dium. D to F: BK 100 % medium as a base. D: 5 % mannitol; E: 10 % mannitol; F: 5 % sucrose. G to J: BK 10 % medium as a base. G: 10 % sucrose; 
H: 10 % sucrose + AIA; I: 5 % mannitol; and J: mannitol 5 % + AIA.
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Regarding germinability assessment, only the four pre-germinative morphological types that recur during in vitro 
culture of Pseudotsuga pollen (Dumont-BéBoux & von Aderkas 1997) were considered for macro development. 
Each type is differentiated by changes in size and circularity, allowing the software to easily distinguish and count 
between the elongated shapes of the viable pollen (type 1 and 2) from the rounded shapes of non-viable pollen (type 
3 and 4) (Webber & Bonnet-Masimbert 1993). This represents an advantage over what is observed in most species, 
where pollen tube elongation implies a challenge for the creation of a reproducible macro, since under in vitro condi-
tions individual tubes grow at different speeds and can take irregular shapes (Webber & Painter 1996); these irregu-
larities may necessitate extensive manual corrections during analysis (Castillo et al. 2022). This limitation may be the 
main reason for the lack of general macros to quantify germination in other species; however, the results presented 
here may be applicable to larch (Larix) pollen, which also follows a pre-germinative pattern similar to Pseudotsuga, 
as well as for other members of the genus (Ho & Rouse 1970, Takaso & Owens 1994, von Aderkas et al. 2012). 

The reproducibility of the analyses was further tested using images from the assays that were conducted to guide 
decision making towards an efficient pollen management protocol (validation). These trials showed that the BK 10 
% medium was sufficient to sustain efficient germination (94.4 %). Commonly, this medium is used in combination 
with sugars, osmoticants and hormones, known to promote the formation of the pre-germinative states as a result of 
changes in the physical properties of the cell membrane (Webber & Bonnet-Masimbert 1993, Dumont-BéBoux & 
von Aderkas 1997), yet we did not find this to be necessary. Additionally, because conifer pollen is generally consid-
ered to be tolerant to desiccation (Webber & Bonnet-Masimbert 1993), the impact of dehydration and rehydration on 
pollen quality was assessed. However, when analyzing the quality of dehydrated Pseudotsuga pollen, a decrease in 
viability between 25 and 50 % was evidenced. Using a rehydration step prior to staining allowed a significant recov-
ery of the viability percentage. Similar reports in Carya illinoinensis (Wangenh.) K.Koch, showed rehydration could  
increase germination to 60 % (Conner 2011). Rehydration allows the cell to restore its metabolic activity and helps 
stabilize and activate membranes before undergoing further osmotic shock, thus improving pollen tube development 
and survival (Webber & Bonnet-Masimbert 1993). 

Evaluation. Mature and induced trees.- In conifer breeding programs -particularly in sexual and asexual seed 
orchards- one of the conditions to be met is to achieve panmixia (random crossing among all individuals), which can 
be difficult when trees in the orchard are not phenologically synchronized, thus requiring management practices to 

Figure 6. Comparison of viability (red) and germination (blue) percentages between adults and induced tree samples.
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ensure stable production of high-quality and genetically diverse seed (Araújo de Oliveira et al. 2021). The applica-
tion of gibberellic acid has been effective in inducing strobilus in Pinaceae because of its involvement in multiple 
physiological responses (Muñoz-Guitiérrez et al. 2010, Vargas-Hernández & Vargas-Abonce 2016). It is an actively 
pursued practice within genetic improvement programs, and for enhancing seed production in plantations. Hence, 
monitoring the quantity and quality of pollen is essential to ensure good fertilization and seed production (Ho 1991, 
Kears & Inouye 1993, Chhun et al. 2007, Kumar & Dwivedi 2014). 

In this study, a comparison between adult and GA4/7 induced trees showed that overall viability and germina-
tion were lower in the latter, and that these decreased as the season progressed. This effect may reflect the carbon 
cost of promoting early pollen production and the formation of reproductive structures in induced trees (Wheeler et 
al. 1980). In natural circumstances, resource accumulation and allocation are critical prior to the formation of the 
strobili (Roland et al. 2014), where a trade-off in resource allocation occurs, negatively impacting other aspects of 
tree growth and development (Crain & Cregg 2018). Exogenously applied gibberellins may cause a redistribution of 
nutrients within shoots (Muñoz-Gutiérrez et al. 2012); for example, in Pinus radiata D. Don, treatment with GA4/7 
resulted in a significant reallocation of 14C and dry matter to and within the terminal bud (Ross 1983). Proper man-
agement, such as irrigation and fertilization before and after induction, as well as during untreated years, can help 
minimize the impact of the treatment and promote proper strobilus formation and pollen production. Furthermore, 
the effect of gibberellin injections on pollen production in Douglas fir has been shown to depend on the age and 
sexual maturity of the tree (Ross 1983), as well as the genotype (Webber et al. 1985), which may relate to the abil-
ity to metabolize exogenous GA4/7 (Kong et al. 2018). Likewise, because of hormone type and dosage, exogenous 
application affects pollen production in P. sylvestris L. by altering development of the strobili (Eriksson et al. 1998) 
and results in low pollen viability in Picea mariana (Mill.) B.S.P. (Ho 1991), as well as in angiosperms such as Oryza 
sativa (Chhun et al. 2007) and Brassica campestris L. (Kumar & Dwivedi 2014).

Medium-term storage.- The 50 % decrease in viability of the Pool sample after four months of storage at 4 °C dem-
onstrates the importance of carrying out pollen conservation practices appropriate to the species. Although pollen 
storage under these conditions is reported to preserve its viability and germination rate (Kadri et al. 2017), these 

Figure 7. Percentage of “Pool” viability over 4 months.
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decline over time. A decreased moisture content of 4-8 %, vacuum-sealed storage atmosphere, replacing air with 
nitrogen, or storage at temperature below -25 °C help promote longevity (Webber & Painter 1996), and should be 
tested further.

Despite the decrease in viability and germinability, our observations show that P. menziesii pollen was able to 
recover from rapid freezing with liquid nitrogen and subsequent storage at -80 °C, thus representing a feasible strat-
egy for medium-term conservation that should be evaluated for longer periods. This agrees with reports for various 
species with desiccation-tolerant pollen, including conifers (Xu et al. 2014). Nevertheless, it is important to point 
out some relevant aspects of monitoring dried and frozen pollen. Firstly, assessment by tetrazolium was the most 
strongly affected by manipulation, usually resulting in the underestimation of viability. This contrasts with prior 
reports (Binder & Ballantyne 1975), although it may reflect the criteria, we used to define viability, where in addi-
tion to coloration, the circularity of the cytoplasm of the pollen grain was considered. During our tests, rehydration 
time may not have been sufficient to allow pollen grains to recover their shape and functionality, which may have 
affected the penetration of the reagent. Dehydration causes changes in the permeability of the exine and the plasma 
membrane, or in cytoplasmic viscosity, which can alter the abundance and function of enzyme systems (dehydro-
genase) (Van Bilsen et al. 1994, Song et al. 2018), as well as limit the presence of respiratory substrates, making 
staining less efficient (Stanley & Linskens 1974). Under these circumstances, it is likely that evaluating germina-
tion, rather than staining, relates better to pollen fertility potential (Cook & Stanley 1960). Further exploration of 
incubation times and nutrient medium composition could favor adequate hydration and provide additional benefits 
(Webber & Painter 1996).

The two macros developed with ImageJ software (Fiji is Just ImageJ) allowed the automated evaluation of P. men-
ziesii pollen viability and germination. This simplified processing of the large quantities of digital images required 
while standardizing conditions for effective pollen handling and storage protocols, which could streamline current 
and future pollination programs. Although the macros we implemented to assess P. menziesii pollen quality were 
reproducible and accurately reflected manual counts, it is important to note that they are not free from generating 
artifacts as a result of inconsistencies in the technical procedure between experiments, since they depend strongly on 

Figure 8. (A) Viability and (B) germination of samples before (red) and after (blue) freezing and storage.
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high image quality. Of particular importance are the incubation times in the stain of choice (here TTC), as well as the 
light intensity when acquiring the images, since changes in the coloration of the pollen grains result in variations in 
the number of pixels. In this case, the threshold must be adjusted manually to discern between viable and non-viable 
pollen, affecting macro accuracy and performance when applied to the rest of the images automatically. Furthermore, 
to ensure high reproducibility, it is important that the pollen grains are not surrounded by particles, such as those of 
plant tissue, and that the grains do not overlap or are too close together. This can be achieved firstly by mixing the 
pollen suspension and placing a drop in the center of the slide before carefully placing the cover slide. The software 
can be used to correct images with overlapping grains by using the Watershed option, which separates nearby par-
ticles; however, it may produce inaccuracies when counting. In addition, the Exclude on Edges option helps to reduce 
the error when assessing germination since incomplete or split type 1-2 pollen grains can be taken as type 3-4, due to 
their proximity to the edge of an image, thereby falsely increasing the proportion of ungerminated pollen.
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